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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As 
a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract.  To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Welcome to This Guide

This guide supplements the current SiteScope 11.10 documentation set, and 
provides information on the new features provided in SiteScope 11.11.

This chapter includes:

➤ How This Guide Is Organized on page 7

➤ Who Should Read This Guide on page 8

➤ Additional Online Resources on page 8

➤ Documentation Updates on page 9

How This Guide Is Organized

The guide contains the following parts:

Chapter 1 Documentation Updates for SiteScope 11.11

Describes how to use the new features that were added in SiteScope 11.11.

Chapter 2 EMS Metrics Flow With Custom Topology - Best Practices

Provides best practices for creating an integration monitor to capture and 
forward metrics samples from a third-party system using the custom 
topology flow.

Chapter 3 EMS Metrics Flow With Computer/Monitor Topology - Best Practices

Provides best practices for creating an integration monitor to capture and 
forward metrics samples from a third-party system using the Computer - 
Monitor topology.
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Chapter 4 EMS Metrics Flow With No Topology - Best Practices

Provides best practices for creating an integration monitor to capture and 
forward metrics samples from a third-party system using the No Topology 
flow.

Who Should Read This Guide

This guide is intended for the following users of SiteScope:

➤ SiteScope/BSM administrators

➤ SiteScope/BSM application administrators

➤ SiteScope/BSM data collector administrators

➤ SiteScope/BSM end users

Readers of this guide should be knowledgeable about enterprise system 
administration, infrastructure monitoring systems, and SiteScope, and have 
familiarity with the systems being set up for monitoring. In addition, 
readers who are integrating with BSM should be familiar with BSM and 
enterprise monitoring and management concepts.

Additional Online Resources

Troubleshooting & Knowledge Base. Enables you to search the Self-solve 
knowledge base in the Troubleshooting page on the HP Software Support 
Web site. Choose Help > Troubleshooting & Knowledge Base. The URL for 
this Web site is http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You can also post to 
and search user discussion forums, submit support requests, download 
patches and updated documentation, and more. Choose Help > HP Software 
Support. The URL for this Web site is www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user 
and sign in. Many also require a support contract.

http://h20230.www2.hp.com/troubleshooting.jsp
http://www.hp.com/go/hpsoftwaresupport
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To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site accesses the HP Software Web site. This site provides 
you with the most up-to-date information on HP Software products. This 
includes new software releases, seminars and trade shows, customer support, 
and more. Choose Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.

Documentation Updates

HP Software is continually updating its product documentation with new 
information.

To check for recent updates, or to verify that you are using the most recent 
edition of a document, go to the HP Software Product Manuals Web site 
(http://h20230.www2.hp.com/selfsolve/manuals).

http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
http://www.hp.com/go/software
http://h20230.www2.hp.com/selfsolve/manuals
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1
Documentation Updates for SiteScope 
11.11

This chapter includes:

➤ "Event Integration for Technology Integration Monitors" on page 12 

➤ "Reporting Topology Without Data for Technology Integration Monitors" 
on page 21

➤ "Virtualization Enhancements" on page 24

➤ "VMware Capacity Management Solution Template" on page 34

➤ "Amazon CloudWatch Custom Metrics Integration" on page 38

➤ "Using the Classic SiteScope Failover Solution" on page 43

Note: This guide supplements the existing SiteScope 11.10 documentation 
set (included with this service pack), and provides information on the new 
features included in SiteScope 11.11. 
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Event Integration for Technology Integration Monitors

Use the Common Event integration to integrate events from third-party 
domain managers or applications to BSM 9.x using Technology Integration 
Monitors (also known as EMS). Unlike the legacy EMS events, the, new BSM 
integration allows users to manage the events in Operations Management 
event sub system and the Service Health console. 

You can use the event field mapping user interface to determine the event 
message content. You can also control topology reporting to BSM. You can 
use one of the two default topologies, Computer and Computer - Running 
Software, or you can report custom topology.

In addition, this new Common Event integration provides the option to 
report topology only to BSM, without reporting the data. For details, see 
"Reporting Topology Without Data for Technology Integration Monitors" on 
page 21. 

This task describes how to enable event integration for SiteScope integration 
monitors:

This task includes the following steps:

➤ "Plan the integration strategy" on page 13

➤ "Configure BSM integration" on page 13

➤ "Configure HP Operations Manager event integration" on page 13

➤ "Configure the integration monitor" on page 14

➤ "Test the field mapping script - optional" on page 19

➤ "Results" on page 20



Chapter 1 • Documentation Updates for SiteScope 11.11

13

 1 Plan the integration strategy

Review the Integration Monitor types. Consider the type of information 
you want to view in BSM from your EMS system. Determine whether one 
of the specific Integration Monitors meets your organization's needs or 
whether a generic Integration Monitor (Technology Log File, Database, 
SNMP Trap, Web Service) is required. 

For more information, see "Integration Monitors Overview" in Using 
SiteScope in the SiteScope help. 

 2 Configure BSM integration

You must integrate SiteScope and BSM. For details, see "How to Configure 
the Integration Between SiteScope and BSM" in Using SiteScope.

 3 Configure HP Operations Manager event integration

Follow the steps for configuring the event integration in "How to Enable 
SiteScope to Send Events to HPOM or BSM" in Using SiteScope.

Note: 

➤ You do not need to select Enable sending events in the HP Operations 
Manager Integrations Main Settings panel (step 9, "Enable SiteScope 
to send events to HPOM or BSM"), because this step applies only to 
sending events for regular SiteScope monitors. Events for integration 
monitors are automatically sent when the integration monitor is 
configured to use the Common Events sample mapping script.

➤ Step 11 "Enable/Disable sending events for monitor instances and 
alerts" is not relevant for enabling or disabling sending events for 
integration monitors.

➤ You do not need to select the Enable HP Operations Manager metrics 
integration check box in the HP Operations Manager Metrics 
Integrations panel.
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 4 Configure the integration monitor

Configure the integration monitor as described in steps 2, 3, 4, and 6 of 
"How to Deploy Integration Monitors" in Using SiteScope.

In step 6, "Edit field mapping and topology script", perform the following:

 a In the Field Mapping area, select the Common Events field mapping 
script, and click Load File. 

Note: In SiteScope 11.11, the Events script was replaced by Legacy 
Events and a new data type, Common Events, was added.

 b Edit the script to enable SiteScope to retrieve the data from the 
monitored application that you want to forward to BSM by mapping 
the following script values to the corresponding field mapping group 
in which they appear in the log file from which you want to extract 
data:

Field Name Description 

Mandatory Values

Title Summary of the event.

Severity Severity of the event. Possible values are: Normal, 
Warning, Minor, Major, and Critical.

SourceHint Information about the monitoring application and the 
corresponding probe/agent that is responsible for 
creating the event.
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Optional Values

CiHint Information about a CI that is related to the event. 

Note: You can use the following formats for CI resolution 
hints: 

➤ Standalone CIs that do not exist in the context of 
Node and descendant CIs. For example, Business 
Application, Business Service, or Siebel Enterprise. CI 
resolution hint should be a CI name.

Example: For a Business Service CI named 
myBusinessService, the CI resolution hint would be: 
MeasurementCIHint(1)="myBusinessService". Note 
that the CI name must be unique in RTSM. 

➤ Node topology and descendant CI types. CI resolution 
hint should be a fully qualified domain name or an IP 
address of a node that follows the @@ separator. 

Example: To report a node with IP address 12.34.56.78, 
the CI resolution hint would be: "@@12.34.56.78" or 
"@@<MachineName>". 

➤ CIs which exist in the context of Node and descendant 
CI types. For example, CIs which belong to CI types 
that inherit from Running Software, Node Element, or 
Network Entity. You must specify in the hint both the 
Node/descendant CI and the CI connected to the 
Node/descendant CI, separated by @@.

Example: For an Oracle Database CI connected to the 
Node/descendant CI, the CI resolution hint should be 
in the format: "<oraclesid>:<product 
name>@@<fqdnhostname>". 

EtiHint Event Type Indicator hint in the format: 
[ETI Name]:[ETI Value]:[Metric Value]

Example: CPULoad:Critical:50

For more information on BSM indicators, see "Health 
Indicators, KPIs, and KPI Domains" in Using Service Health 
in the BSM Documentation Library.

Field Name Description 
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ComponentCi Information used to identify a subcomponent of a CI. 
This CI subcomponent is used to calculate an aggregated 
status within BSM's Service Health for selected CIs.

If an HI is populated by events from multiple 
components, you can specify a component name in this 
field in order to ensure the correct calculation of the HI 
state.

Example: If you have a Computer CI with two CPUs, cpu 
#1 and cpu #2, events from both CPUs will be sent to the 
same CPU Load HI. By default, the events will override 
each other and create an incorrect HI state. To prevent 
this, you can populate ComponentCi with values "cpu #1" 
and "cpu #2" which will cause the HI state to be 
calculated as an aggregated state between the two events. 

HostHint Information about a CI of type Node that is hosting the 
CI related to the event. This field is mandatory when 
reporting topology which includes Node CIs.

Description Additional information describing the event.

Category Name of a logical group to which the event belongs. An 
event category is similar to a message group in HPOM.

Example: Database, Security, Network 

SubCategory Name of a logical subgroup (category) to which the event 
belongs.

Example: Oracle (database), Accounts (security), Routers 
(network)

Key A unique string representing the type of event that 
occurred. Two events can have the same key if both 
events represent the same situation in the managed 
environment. Events with the same key are treated as 
duplicates. 

Example: foohost:barhost:CPULoad:Critical 

Field Name Description 
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CloseKey Enables the event that is sent to close all events whose 
Key attribute matches the CloseKey pattern expression. 
You can use wildcards (*) if necessary.

Example: barhost:CPULoad<*>

LogOnly This field allows submitting an event that goes directly 
into the history event browser as a closed event. Such an 
event goes though the complete event processing (CI 
Resolution, updating HIs, and so forth), but has its Life 
Cycle State set to closed from the beginning. For details 
on CI Resolution, see "CI Resolution" in Using Operations 
Management in the BSM Documentation Library.

Typical examples of events having this attribute set to 
"True" are events that will result in resetting a Health 
Indicator to a "Normal" or "Good" state, or an event 
signaling that a previous problem no longer exists (where 
the problem was reported in another event).

Possible values are:

➤ True. Logs all events automatically on arrival.

➤ False. Events are not logged automatically.

➤ True for normal severity. Automatically logs events 
with Normal severity only.

Default value: False

Attributes

#cma1=

#cma2=

#cma3=

#cma4=

#cma5=

Use these attributes to send any custom attributes in the 
event. 

Note: Only the predefined custom mapping attributes are 
supported. You cannot change a custom attribute name 
(cma1-cma5) or add a new one. 

Field Name Description 
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 c Optionally, you can map the data to a topology script to forward the 
data to the correct CI hierarchy in BSM. In the Topology Settings area, 
select a topology script template from the following options:

➤ Computer. Select to create a topology with a Computer CI. 

Note: Information about Computer CI is taken from the HostHint 
field.

➤ Computer - Running Software. Select to create a topology with a 
Computer CI as the parent CI and a Running Software CI under it.

Note: Information about Computer CI is taken from the HostHint 
field and the name of the Running Software CI is taken from the 
Category field.

➤ Custom. Select to create your own topology script.

Note: 

➤ Computer and Computer - Running Software out-of-the-box topology 
scripts that are available for the Common Events data type only. 

➤ The following scripts are available only when SiteScope is connected to 
BSM versions 9.x or later: Computer, Computer - Running Software, 
Node, and Node - Running Software.
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Edit the topology settings. The topology templates are specially 
configured with the necessary values to forward data to the required 
CIs in BSM's RTSM.

Note: 

➤ When using field mapping, you can use the field mapping fields as an 
input for topology script. For example, if using common event 
mapping, you can access the value of the Category field in the 
following way:
category = Framework.getDestinationAttribute("Category")

➤ In addition, you can access values of the "monitor variables", such as 
group0, group1, and so forth, from Technology Log File Integration 
monitor, or the names of database columns in Technology Database 
Integration monitor, or other variables in the other integration 
monitors. For example, you can access the value of the group1 variable, 
in the following way:
group1 = Framework.getDestinationAttribute("group1")

 5 Test the field mapping script - optional

In the Topology Settings area, click Test Script to test the script before 
running the monitor. This tests the following:

➤ Checks the field mapping and topology script syntax.

➤ Displays the mapping results.

➤ Displays the topology results if a topology script has been configured.

The test does not forward events or topology to BSM.
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 6 Results

When events are gathered from a third-party system and processed by 
integration monitors, common events are generated, and SiteScope writes 
the event data to the HPSiteScopeOperationsManagerIntegration.log file 
in the <SiteScope root directory>\logs directory. Each event is written as 
a separate line in the log. The log file policy instructs the agent to read 
this file and create event messages that are sent to BSM.

You can view the event in the Operations Management Event Browser (if 
you have an Event Management Foundation license). If Operations 
Management is not part of your BSM installation, you can view events 
that affect CI status using a health indicator in Service Health.
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Reporting Topology Without Data for Technology
Integration Monitors

You can have SiteScope report only the topology discovered by the SiteScope 
Technology Integration monitors, without reporting the data.

This task includes the following steps:

➤ "Configure the Technology Integration monitor" on page 21

➤ "Test the script - optional" on page 23

 1 Configure the Technology Integration monitor

 a When configuring a Technology Integration monitor, in the Topology 
Settings panel, select the Report topology without data check box.

Note: When this option is selected, the Field Mapping area is not 
available.

 b Select a topology script template from the following options:

➤ Computer. Select to create a topology with a Computer CI. 

➤ Computer - Running Software. Select to create a topology with a 
Computer CI as the parent CI and a Running Software CI under it. 

➤ Custom. Select to create your own topology script, if you want the 
retrieved data to be sent to specific CIs instead of the Computer or 
Running Software CIs.



Chapter 1 • Documentation Updates for SiteScope 11.11

22

 c Map the data discovered by the monitor to the relevant attributes in 
the topology settings. The topology templates are specially configured 
with the necessary values for reporting topology only to BSM.

The following values are mandatory:

Note: 

➤ Computer and Computer - Running Software are out-of-the-box 
topology scripts that are available for the report topology without data 
type flow. 

➤ The Computer and Computer - Running Software scripts are available 
only when SiteScope is connected to BSM versions 9.x or later.

For Template Field Name Description 

➤ Computer

➤ Computer - 
Running Software

target_name The name of the host machine. This 
can be added manually or taken 
from Framework.getDestination
Attribute("<someAttribute>").

Example: 
Framework.getDestinationAttribute(
"group0") 

➤ Computer

➤ Computer - 
Running Software

target_ip IP of the host machine. This can be 
added manually, calculated using 
HostIPCachingManager.getIPByHost
Name(target_name) if target_name 
represents a valid host machine, or 
you can use 
HostIPCachingManager.getIPByHost
Name("<someAttribute>").

Computer - Running 
Software

name Running Software name. This can 
be added manually or taken from 
Framework.getDestination
Attribute("<someAttribute>").
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Note: You can access values of the "monitor variables", such as group0, 
group1, and so forth, from Technology Log File Integration monitor, or 
the names of database columns in Technology Database Integration 
monitor, or other variables in the other integration monitors. For 
example, you can access the value of the group1 variable, in the following 
way:
group1 = Framework.getDestinationAttribute("group1")

 2 Test the script - optional

In the Topology Settings area, click Test Script to test the script before 
running the monitor. This displays the topology results.

The test does not forward topology to BSM.
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Virtualization Enhancements

Enhancements were made to the SiteScope Virtualization monitors (VMware 
Host and VMware Performance) in the following areas:

➤ "Added New Configuration Metrics to the Virtualization Monitors" on 
page 24

➤ "Metrics Integration Support for VMware Monitors" on page 25

➤ "Extended Topology Reporting for VMware Monitors" on page 28

➤ "Added Option to Deploy VMware Performance Monitor Without 
Connecting to Server" on page 32

➤ "Tuning the System for Loaded Environments" on page 32

Added New Configuration Metrics to the Virtualization 
Monitors
Configuration metrics for the VMware ESX Host and VMs (such as Total 
physical memory available on the host, number of cores, and others) were 
added to the VMware Performance and VMware Host monitors.

For details, see the SiteScope Monitor Metrics and Measurements document, 
available from <SiteScope root directory>\sisdocs\pdfs\ 
SiteScope_Monitors_Metrics.doc or from the SiteScope Home page in the 
SiteScope Help. You can also access the documentation in the HP Software 
Support Web site.

http://h20230.www2.hp.com/selfsolve/manuals
http://h20230.www2.hp.com/selfsolve/manuals


Chapter 1 • Documentation Updates for SiteScope 11.11

25

Metrics Integration Support for VMware Monitors
SiteScope uses the HP Operations agent to make metrics data from VMware 
Host and VMware Performance monitors available to HP Performance 
Manager and to the Performance Perspective tab in BSM's Operations 
Management. 

The reported metrics are now associated with the relevant resource: ESX 
host, VM, or Resource Pool. The target is the counter target (not the monitor 
target). 

How to Enable SiteScope to Report VMware Monitor Metrics to 
the HP Operations Agent

This task describes how to enable SiteScope to report VMware monitor 
metrics to the HP Operations Agent. It includes the following steps:

➤ "Enable SiteScope to report metrics to the HP Operations Agent" on 
page 26

➤ "Configure the VMware monitor" on page 26

➤ "Configuring integration preferences - optional" on page 26

Monitor Type
Reports Metrics 
For

Reports Metrics to the Following 
Tables

VMware Host ESX VMware Host CPU, Memory, 
Storage, State, Network, System 
tables

VMs VMware VM CPU, Memory, 
Storage, State, Network, System 
tables

VMware Performance ESX VMware Host CPU, Memory, 
Storage, State, Network, System 
tables

VMs VMware VM CPU, Memory, 
Storage, State, Network, System 
tables

Resource Pool VMware Resource Pool table
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 1 Enable SiteScope to report metrics to the HP Operations 
Agent

To enable SiteScope to report metrics to HPOM and BSM reporting 
products, the HP Operations agent must be installed on the SiteScope 
server, and the HP Operations Manager metrics integration must be 
enabled. For details on configuring the metrics integration, see "How to 
Enable SiteScope to Report Metrics to the HP Operations Agent" in Using 
SiteScope.

 2 Configure the VMware monitor

 a Configure the monitor properties. 

For details, see the Monitor Settings page for the specific monitor in 
Monitor Reference 11.10.

 b Enable the VMware monitor to send metrics to the HP Operations 
agent. 

For each VMware monitor instance that you want to report metrics 
data to the agent data storage, expand HP Integration Settings in the 
monitor properties, and select Report metrics to HP Operations agent 
in the HP Operations Manager Integration Settings section.

 3 Configuring integration preferences - optional

You can modify the settings related to the VMware monitors in 
Preferences > Infrastructure Preferences > Monitoring Settings. For 
details on these settings, see "Notes and Limitations" on page 27.
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Notes and Limitations

➤ To support motion and changes in the vCenter, such as change of IP or 
host name, you can change the interval for updating the data saved to the 
cache in the Frequency of VM configuration retrieval from vCenter 
(hours) field in Preferences > Infrastructure Preferences > Monitor 
Settings. By default, data is updated every 4 hours. You can also configure 
this by modifying the _vmwareRetrieveConfFrequencyHours property in 
the <SiteScope root directory>\groups\master.config file.

➤ By default, the VMware Performance monitor sends each metric to a 
specific table with its ESX host server, VM, or resource pool target, 
according to its data type. To revert back to the old behavior where the 
monitor sends all metrics to one table, clear the Report VMware 
Performance monitor metrics to OA metrics classes check box in 
Preferences > Infrastructure Preferences > Monitor Settings. You can also 
modify this setting in the <SiteScope root directory>\groups\
master.config file by changing the _omReportNewVmwareMetricClasses 
property value to =false.

➤ The VMware Performance monitor supports the following metrics types 
only: CPU, disk, memory (mem), network (net), state and sys (system). All 
other metrics types are currently not supported, including general metrics 
such as usageToPresevationRelation and usageToLimitRelation metrics.

➤ The first time you start monitoring a new VM or ESX host, it takes more 
time to get the data and to view it in the HP Operations agent.
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Extended Topology Reporting for VMware Monitors
VMware Performance and VMware Host monitors can identify the topology 
of the VMware servers being monitored. The monitors create the following 
topology in BSM's RTSM. 

Extended topology reporting for the VMware Performance and VMware 
Host monitors:

➤ VMware Host monitors: Added cluster and datacenter CI types for 
reporting topology. 

➤ VMware Performance monitor: Added cluster and resource pool CI types 
for reporting topology.

Each selected counter for VMware Host or Performance monitors is reported 
to RTSM as a SiteScope measurement and is linked to the relevant SiteScope 
measurement group and monitored CI (VM, ESX, and so forth).
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VMware Host Monitors

The VMware Host monitors (VMware Host CPU, VMware Host Memory, 
VMware Host Storage, VMware Host Network, VMware Host State) report to 
BSM's RTSM the following topology:

Note: VMware Host monitors report cluster and datacenter topology only 
with a connection to vCenter.
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VMware Performance Monitor

The VMware Performance monitor now reports to BSM's RTSM the 
following topologies (in addition to reporting the Node CI for the virtual 
machine (VM) and the VMware ESX Server CI (ESX), and the connection 
between the VM and ESX):

Cluster to Virtual Machine:
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Cluster to ESX Server:

Cluster to Resource Pool:
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Added Option to Deploy VMware Performance Monitor 
Without Connecting to Server
Added the Verify monitor properties with remote server check box to the 
Deployment Values dialog box when deploying the VMware Performance 
monitor from a template. Clearing this option deploys the monitor without 
having to connect to the server, thereby enabling template deployment on 
powered on and powered off VMs. When this option is selected (the default 
setting), deployment fails for VMs that are not powered on.

Tuning the System for Loaded Environments
SiteScope installed on a 64-bit environment supports configurations with up 
to 2150 VMware Host and VMware Performance monitors running 
concurrently. This loaded system can be integrated with BSM and OM 
metrics.

To support loaded environments, the following system tuning is required:

➤ SiteScope sizing is required to increase JVM heap size, desktop heap size, 
and the number of file handles. You can use the SiteScope Configuration 
Tool to size SiteScope. For details, see "Using the SiteScope Configuration 
Tool" in the HP SiteScope Deployment Guide PDF.

➤ Add the _runGCPeriod=1200000 property to the 
<SiteScope root directory>\groups\master.config file. This means that 
SiteScope initiates running the garbage collector every 20 minutes 
(1200000 milliseconds) for better performance.

➤ Tune the following vCenter/ESX connection parameters in the 
<SiteScope root directory>\groups\master.config file (as required):

➤ _vmWareConnectionPoolMaxIdlePervCenterKey=

➤ _vmWareConnectionPoolMaxSizePervCenterKey=

➤ _vmWareConnectionPoolMaxTotal=

➤ _vmWareConnectionTimeOut=
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➤ Increase the number of dynamic monitors handles in Preferences > 
Infrastructure Preferences > Dynamic Monitoring Settings:

➤ Dynamic monitoring core thread pool size: 50

➤ Dynamic monitoring maximum thread pool size: 70
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VMware Capacity Management Solution Template

Added the VMware Capacity Management solution template. This solution 
template enables SiteScope to collect data from VMware monitors and 
report it to the data store on the HP Operations agent. This data can then be 
used in various supported reporting products, including HP Service Health 
Optimizer (SHO), HP's capacity management solution, and Service Health 
Reporter (SHR), HP's service centric cross-domain reporting solution.

Note: You must have the VMware Host Solution Template Optional License 
to use the VMware Capacity Management solution template. Contact your 
HP sales representative for more information about Solution licensing.

This section includes:

➤ "Solution Template Monitors" on page 34

➤ "How to Deploy the VMware Capacity Management Solution Template" 
on page 37

Solution Template Monitors
The VMware Capacity Management solution consists of the following 
templates: 

➤ "Template for Monitoring VMware Host" on page 35 

➤ "Template for Monitoring the Resource Pool" on page 36

➤ "Template for Monitoring VM" on page 36

Note: The template monitors are not configured with threshold settings, 
since the reporting products require raw data and topology only.
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Template for Monitoring VMware Host

The VMware Host template uses VMware Host monitors to monitor 
performance and configuration metrics for the Hosts. The Template is per 
single Host, and should be deployed for all Hosts.

The template includes the following monitors:

➤ VMware Host CPU monitor

➤ VMware Host Memory monitor

➤ VMware Host Storage monitor

➤ VMware Host Network monitor

➤ VMware Host State monitor

Note: The counters in these monitors are not the same counters as in the 
VMware Host solution template.

When deploying the template, you need to specify the following template 
variables: Host name, connection_link (vCenter or Host URL), username 
(vCenter or Host username with view host permissions), password (vCenter 
or Host password), is vCenter (true if vCenter; false if Host), and select the 
Verify monitor properties with remote server check box during template 
deployment.

The VMware Host monitors also report the following topology to BSM:

➤ Cluster -> Host

➤ Datacenter -> Host

➤ Datacenter -> Cluster
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Template for Monitoring the Resource Pool

The Resource Pool template uses the VMware Performance monitor to 
monitor performance and configuration metrics for the Resource Pool. This 
template is per single Resource Pool, and it should be deployed for all 
Resource Pools.

When deploying the template, you need to specify the following template 
variables: resource pool name, vCenter url, username (vCenter username 
with view Resource Pool permissions), password (vCenter password), and 
select the Verify monitor properties with remote server check box during 
template deployment.

The VMware Performance monitor also reports the following topology to 
BSM:

➤ Cluster -> Resource Pool 

➤ ESX Host -> VM

➤ Cluster -> VM

➤ Cluster -> Resource Pool to VMs

Template for Monitoring VM

The VM template uses the VMware Performance monitor to monitor 
performance and configuration metrics for the VMs. The Template is per 
single VM, and should be deployed for all VMs.

When deploying the template, you need to specify the following template 
variables: vm (VM name), vCenter URL, username (vCenter username with 
view VM permissions), password (vCenter password).

Note: We recommend clearing the Verify monitor properties with remote 
server check box during template deployment. Clearing this option deploys 
the monitor without connecting to the server, thereby enabling template 
deployment on powered on and powered off VMs. When this option is 
selected (the default setting), deployment fails for VMs that are not powered 
on.
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The VMware Performance monitor also reports the following topology to 
BSM:

➤ ESX Host ->  VM

➤ Cluster -> VM

➤ Cluster -> Resource Pool -> VMs

How to Deploy the VMware Capacity Management 
Solution Template
This task describes how to deploy the VMware Capacity Management 
solution template. 

It includes the following steps:

➤ "Prerequisites" on page 37

➤ "Deploy the template" on page 37

 1 Prerequisites

➤ You must have the VMware Host Solution Template Optional license 
to use the Solution Template. Contact your HP sales representative for 
more information about Solution licensing.

➤ The license must be imported from a license file in Preferences > 
General Preferences > Licenses.

 2 Deploy the template

We recommend deploying the solution template using a CSV file, since 
you can perform multiple deployments at one time, without having to 
manually enter variable values for each deployment in the user interface. 

You can create a CSV file for the VMware Capacity Management 
templates using the vSphere client export to file option (File > Export > 
Export List). This enables you to export all VM names, Resource Pool 
names, and Host names to the CSV file. After creating the file, you can 
edit the file and add template variables such as vCenter URL, username, 
and password.

For more information on deploying a SiteScope Solution Template, see 
"How to Deploy a SiteScope Solution Template" in Using SiteScope.
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Amazon CloudWatch Custom Metrics Integration

Added support for the Amazon CloudWatch Custom Metrics integration. 
This integration enables customers who use SiteScope for monitoring their 
AWS-hosted applications to report any SiteScope metrics to an Amazon 
CloudWatch service. Amazon CloudWatch enables Auto Scaling, reporting 
and alerting.

This section includes:

➤ "How to Configure the Amazon CloudWatch Custom Metrics Integration" 
on page 38

➤ "Amazon CloudWatch Integration Preferences Dialog Box" on page 39

How to Configure the Amazon CloudWatch Custom 
Metrics Integration
This task describes the steps involved in configuring the Amazon 
CloudWatch integration. 

This task includes the following steps:

➤ "Prerequisites" on page 39

➤ "Configure the integration settings" on page 39

➤ "Results" on page 39
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 1 Prerequisites

Only an administrator in SiteScope, or a user granted Edit integration 
preferences permissions can create or make changes to Integration 
Preferences. For details on user permissions, see "User Management 
Preferences Overview" on page 928.

 2 Configure the integration settings

 a Select Preferences > Integration Preferences. In the Integration 
Preferences page:

➤ Click the New Integration  button and select Amazon 
CloudWatch Integration, or 

➤ Select an existing Amazon CloudWatch integration and click Edit 
Integration .

 b Configure the integration settings as described below.

 3 Results

SiteScope reports EC2 data to the Amazon CloudWatch service.

Amazon CloudWatch Integration Preferences Dialog Box
This dialog box enables you to create a new Amazon CloudWatch 
integration or to edit an existing integration. This is used to forward 
SiteScope data to an Amazon CloudWatch service.

UI Element Description

General Settings Panel

Name Name by which to identify this integration in the 
SiteScope interface. 

Note: This is a required field.

Description Description of the integration. This could include 
information on the application receiving the data from 
SiteScope. This description appears only in the 
Integration Preferences page in SiteScope.
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Amazon CloudWatch Integration Preferences Settings Panel

Namespace The namespace corresponding to the service of interest.

Note: This is a required field.

Default value: HP/SiteScope

Encoding Encoding used by the receiving application. 

Default value: UFT-8 

Reporting interval 
(seconds) 

Time in seconds between when SiteScope finishes 
sending data to the next period SiteScope begins sending 
data. 

Note: This is a required field.

Default value: 60 seconds 

Time synchronization 
interval (minutes)

To synchronize between the time of the SiteScope server 
and the server receiving SiteScope data, SiteScope can 
periodically report the time that is registered on its 
server. The receiving server can then synchronize the 
time of the data samples coming from SiteScope with the 
time on its own server so that there is no discrepancy 
between the time of the SiteScope data and the 
application's own data. 

Select in minutes how often you want SiteScope to report 
to the time of the SiteScope server to the server receiving 
SiteScope data. 

Default value: 10 minutes 

Request timeout 
(seconds) 

Timeout, in seconds, until a connection is established 
with the server. A value of zero means there is no 
timeout used. 

Note: This is a required field.

Default value: 120 seconds

Connection timeout 
(seconds) 

Socket timeout, in seconds, to wait for data. A timeout 
value of zero means there is no timeout used. 

Note: This is a required field.

Default value: 120 seconds

UI Element Description



Chapter 1 • Documentation Updates for SiteScope 11.11

41

Number of retries Number of times SiteScope attempts to establish a 
connection. 

Default value: 3 

Disable integration SiteScope does not forward data to the server. The 
integration preference setting remains. Use when 
temporarily disabling the integration. 

Default value: Not selected 

Amazon CW Security Settings Panel

AWS Access Key ID An alphanumeric token that uniquely identifies a 
request sender. This ID is associated with your AWS 
Secret Access Key.

AWS Secret Key The key assigned to you by AWS when you sign up for an 
AWS account. Used for request authentication. 

Proxy Server Settings Panel

NTLM V2 Proxy Select if the proxy requires authentication using NTLM 
version 2.

Default value: Not selected 

Address Proxy server address if applicable.

User name Username for the proxy server.

Password Password for the specified server.

UI Element Description
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Reporting Tags Panel

<Tag name and 
values>

SiteScope uses the tag selected here to determine what 
data is forwarded to the receiving application. You must 
select at least one tag for each integration. That same tag 
must be selected for the groups, subgroups, and monitors 
whose data you want forwarded to the receiving 
application.

When selecting an integration tag for an object, the tag 
propagates to that object’s children. If you tag a group 
with this Integration tag, all its subgroups and monitors 
report their status to the receiving application.

Example: Create a tag called Integration1 and select it 
here. For each group, monitor, or both, whose status you 
want to report to the receiving application, select this tag 
under the Search/Filter Tags setting for the object.

Note: You can select multiple tags for each integration 
preference. You can select multiple Integration tags for 
the objects to be reported.

Add Tag Opens the New Tag dialog box, enabling you to add new 
keyword tags. For user interface details, see "New/Edit 
Tag Dialog Box" on page 167.

Tip: Use the word Integration when creating an 
Integration tag. Because the Integration tags appear 
along with all other Search/Filter tags created for the 
SiteScope, this helps you identify which tag to select for 
enabling a group or monitor for the integration.

UI Element Description
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Using the Classic SiteScope Failover Solution

The classic SiteScope Failover solution was reinstated as an alternative to 
using the SiteScope Failover Manager solution (introduced in SiteScope 
11.00) for providing automated failover functionality. This enables you to 
choose the failover solution that best suits your needs. 

➤ The classic solution simplifies the upgrade to SiteScope 11.x for existing 
customers, and does not require additional hardware. Classic SiteScope 
Failover can be enabled from the SiteScope Configuration Tool.

➤ The new SiteScope Failover Manager solution has many benefits, such as 
data and configuration continuity, although it does require additional 
hardware. 

➤ It is planned to consolidate these two failover solutions in a future 
SiteScope release

Note: To use SiteScope in classic SiteScope Failover mode, a valid 
SiteScope Failover license file is required. If you do not have a valid license 
file, you can submit a request to renew or upgrade your license using the HP 
License Key Delivery Service site.

To change SiteScope to classic SiteScope Failover mode:

 1 Open the SiteScope Configuration Tool (Start > Programs > HP SiteScope 
> Configuration Tool).

 2 In the Introduction screen, select the Change to classic SiteScope Failover 
mode check box, and then click Next.

 3 The Change to classic SiteScope Failover mode screen opens.

Click Next to complete the change to classic SiteScope Failover operation.

 4 Open a Web browser and direct it to open the SiteScope Failover instance. 
For example, http://localhost:8080/SiteScope.

 5 In the left panel, select the Preferences context menu, and click General 
Preferences. In the Licenses section, click Select and select the SiteScope 
Failover (High Availability) license key file.

https://webware.hp.com/Welcome.asp
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 6 In the preferences menu section, click Failover Preferences. The Failover 
Preferences page opens. Enter the name or IP address and port of the 
primary SiteScope server and the login credentials as described in 
“Configuring Failover Preferences” in the HP SiteScope Failover Guide PDF.

 7 Click Mirror Configuration Now to continue. SiteScope copies all the files 
over from the primary machine and restarts when the mirroring 
operation is complete.

 8 After the failover has restarted, refresh your Web browser or redirect your 
browser to the SiteScope Failover address. If there are SiteScope user 
names and passwords defined on the primary SiteScope, enter the same 
user names and passwords to access the failover.

For details on using classic SiteScope Failover, see the HP SiteScope Failover 
Guide PDF available from <SiteScope root installation>\sisdocs\pdfs\
ClassicSiteScopeFailover.pdf. 

Operations Manager Metrics Integration Support with Classic 
SiteScope Failover

Classic SiteScope Failover 11.11 provides support for OM metrics 
integration. Note that SiteScope Failover reports metrics to its HP 
Operations agent (not to the primary's agent).

Operations Manager Event Integration with Classic 
SiteScope Failover

To enable classic SiteScope Failover support for OM event integration, 
perform the steps in "How to Enable SiteScope to Send Events to HPOM or 
BSM" in Using SiteScope in the SiteScope help, both for the primary SiteScope 
and for the SiteScope Failover.

Event flow and host discovery flow work without any additional steps. For 
the Monitor Discovery integration, follow the steps in "How to Enable the 
SiteScope Monitor Discovery Policy" in Using SiteScope in the SiteScope help 
for the primary SiteScope only.
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Notes and Limitations

➤ Since there will be only one SiteScope service tree (and it is affected by 
events), it is not possible to know if it is affected by what was reported 
from the primary or failover SiteScope.

➤ The Failover group is not displayed since this group is on the failover 
server only.

➤ When the primary is down, events triggered from monitors that are 
monitoring the SiteScope server (in this case, the SiteScope server is the 
failover) do not affect the service tree.

➤ Groups and monitors added when the primary is down are not displayed 
in the service tree.

➤ The Drill Down to SiteScope tool works only when the primary SiteScope 
is running.

➤ If there are different agent configurations on the primary and SiteScope 
Failover (for example, an agent is installed on a different path), the agent 
command on the failover server will not run from the Event Integration 
preferences user interface and you need to enter the agent path manually 
beforehand.



Chapter 1 • Documentation Updates for SiteScope 11.11

46



47

2
EMS Metrics Flow With Custom Topology 
- Best Practices

This chaptersection includes:

➤ "Create a Metrics Flow With Custom Topology" on page 47

➤ "Example – Create a Metrics Flow With Custom Topology" on page 56

Create a Metrics Flow With Custom Topology

This task describes the steps involved in creating an integration for metrics 
samples using the custom topology flow.

Note: For an c of this task, see "Example – Create a Metrics Flow With 
Custom Topology" on page 56. 

This task includes the following steps:

➤ "Design the Topology Flow" on page 48

➤ "Change the CI Resolver TQL" on page 48

➤ "Select an Indicator" on page 49

➤ "Define an HI Assignment" on page 50

➤ "Define a KPI Assignment for each CI type" on page 51

➤ "Configure Field Mapping" on page 52
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➤ "Create the Custom Topology Script" on page 53

➤ "View Integration Results" on page 54

 1 Design the Topology Flow

The first stage in creating an EMS integration for metrics samples using 
the custom topology flow is the design. When planning the design 
strategy, you need to consider the following:

➤ CIs for topology

Consider the entities that you want to report to BSM. For these 
entities, you might also want to report data and to view the health 
status of these entities in BSM’s Service Health.

For example, you have a third-party application named TPA that writes 
to a database. The entries in this database contain performance data 
on CPU and network usage of different computers. In this case, you 
will probably want to create a topology that reports Computer CIs to 
BSM.

➤ Data that you want to be reported for these CIs

Consider what data you have for these CIs and how it can be attached 
to the CIs. What is the relevant health indicator (HI) for the data being 
reported? If there is no such indicator, consider creating a new HI. 
Which KPI or HI assignments create the desired HIs and KPIs? If no 
such assignments exist, consider creating your own.

 2 Change the CI Resolver TQL

 a In BSM, select Admin > Platform > Infrastructure Settings. 

➤ Select Applications.

➤ Select End User/System Availability Management.

➤ In the End User/System Availability Management - SiteScope CI 
Resolver Settings, change the value of the TQL Queries parameter 
from CIs Monitored by SiteScope to OMiAutoView. 
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 b Restart BSM to apply the change.

Note: This TQL does not support models with a large number of CIs (it 
may cause performance problems in such models).

 3 Select an Indicator

To view the status of a CI, you need an HI which provides a fine-grained 
measure of the health of the CI. In most cases, you want to view the HI in 
BSM’s Service Health. The HI is also used in Service Level Management 
(SLM). For details on HIs in Service Health and SLM, see "Health 
Indicators and KPIs - Overview" in Using Service Health in the BSM 
Documentation Library.

Note: For alignment reasons, we recommend using an out-of-the-box HI; 
only create your own HI if you do not find an existing HI that fits your 
needs.

To select an existing HI or create a new HI:

 a In BSM, select Admin > Service Health / Service Level Management > 
Repositories > Indicators. 

 b From the CI type hierarchy in the left pane, select the CI type which 
you are going to report from your topology script. The assigned 
indicators for the CI type are displayed in the Indicators pane. When 
you select an indicator, its details are displayed in the right pane. For 
more details on topology scripts, see step 7 on page 53.

 c Check if you already have an existing HI that fits your requirements. If 
you do not, create a new one. For details on how to create HIs, see 
"How to Create or Edit an ETI or HI Template in the Indicator 
Repository" in Using Service Health in the BSM Documentation Library.
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 d If you create a new HI, you should publish the changes to SiteScope. In 
BSM, select Admin > System Availability Management > Metrics and 
Indicators and click Publish Changes. The changes should reach 
SiteScope within no more than 5 minutes.

 4 Define an HI Assignment

After you select an HI, you need to define an HI assignment that will 
assign the HI to a CI. The assignment also defines which data samples will 
be captured by this HI and which business rule will be used to calculate 
the status of the HI according to the data samples.

For more information on HI assignments in Service Health, see "Health 
Indicator Assignments Page" in Using Service Health in the BSM 
Documentation Library. For more information on HI assignments in SLM, 
see "Health Indicator Assignments Page" in Using Service Level Management 
in the BSM Documentation Library.

To define an HI assignment:

 a In BSM, select Admin > Service Health / Service Level Management > 
Assignments > Health Indicator Assignments. 

 b From the CI type hierarchy in the left pane, select the CI type which 
you are going to report from your topology script. The assigned 
indicators for the CI type are displayed in the Indicators pane. When 
you select an indicator, its details are displayed in the right pane. For 
more details on topology scripts, see step 7 on page 53.

 c Create a new HI assignment. For details on how to create the 
assignment, see "How to Define a KPI or HI Assignment" in Using 
Service Health or "How to Define a KPI or HI Assignment" in Using 
Service Level Management in the BSM Documentation Library.

➤ In the Condition area, enter a unique value for your integration in the 
Monitored By field. This enables you to distinguish between the CIs 
reported by your integration to other CIs of this type which are not 
reported by the integration.

➤ When you create the topology script for the monitor, enter the 
monitored_by attribute with this value on the CI you report. For more 
details on topology scripts, step 7 on page 53.
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➤ Select the HI you chose in step 3.

➤ Choose the business rule to use for the HI calculation. We recommend 
using the SiteScope Worst Status Rule. You can also use the SiteScope 
Consecutive Worst Status Log or SiteScope Best Status Rule.

➤ In the selector, enter the following:

➤ eti_id = (Binary) <<Health Indicator Type ID>>

➤ ci_id = (Binary) <<CI ID>>

➤ sampleType = (String) ss_t

The integration monitor sends metrics samples (ss_t) that contain the 
same eti_id as your ETI and same CI ID as the CI's.

The eti_id in the sample is sent by SiteScope according to your field 
mapping entry for the monitor in step 6.

The ci_id is found by the CI resolver in BSM. For it to find the CI, it 
uses the CI hint sent by SiteScope in the sample, according to your 
field mapping entry for the monitor in step 6.

For details on field mapping for metrics samples, see "Configuring 
Field Mapping for Metrics Samples" in Using SiteScope.

 5 Define a KPI Assignment for each CI type

Verify whether you have an appropriate KPI assignment, or create if one 
does not already exist.The assignment determines which KPI to put on 
the CI and for which HIs.

If you use one of the default HIs then there should already be a default 
KPI assignment for your HI and you do not need to create one. 

➤ For more information on KPI assignments in Service Health, see "KPI 
Assignments Page" in Using Service Health in the BSM Documentation 
Library.

➤ For more information on KPI assignments in Service Level 
Management (SLM), see "KPI Assignments Page" in Using Service Level 
Management in the BSM Documentation Library.
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To create a KPI assignment:

 a In BSM, select Admin > Service Health > Repositories > Indicators. 

 b From the CI type hierarchy in the left pane, select the CI type which 
you are going to report from your topology script. The assigned 
indicators for the CI type are displayed in the Indicators pane. When 
you select an indicator, its details are displayed in the right pane. For 
more details, see "Create the Custom Topology Script" on page 53.

 c Create a new KPI assignment. For details, see "How to Define a KPI or 
HI Assignment or "Applications" in Using Service Health or "How to 
Define a KPI or HI Assignment" in Using Service Level Management in the 
BSM Documentation Library.

 d In the KPI assignment, the related HI should be the one you chose in 
step 3.

Note: If you also want to view the integration results in Service Level 
Management (SLM), you need to define the Service Level Agreement 
(SLA). For more information on SLAs, see "Agreements Manager Page" 
in Using Service Level Management in the BSM Documentation Library.

 6 Configure Field Mapping

Now it is time to configure the monitor. In the Field Mapping section of 
the integration monitor, select the Metrics sample type to load the 
metrics script, and enter the details you want to send in the ss_t sample 
file. 

➤ For the MeasurementETI value, enter the label of the HI you chose 
previously in step 3. 

➤ Enter a hint for the CI in MeasurementCIHint. This hint helps the CI 
resolver in BSM to recognize the CI to which the sample should be 
attached. 

For details on values for the metrics script, see "Configuring Field 
Mapping for Metrics Samples" in Using SiteScope.
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 7 Create the Custom Topology Script

Finally you should create the topology script. The script defines how to 
report CIs to BSM. For details on the topology script, see "Topology 
Settings for Technology Integration Monitors" in Using SiteScope.

For the monitored_by attribute of the CI, enter the identifier for this 
integration. This is the same value you used in the HI assignment in 
step 4.

Note: 

➤ Same note also in 1. Working with SiteScope Integration Monitors > 
Topology Settings for Technology Integration Monitors > "Editing the 
Topology Script". 2. Working with SiteScope Integration Monitors > 
How to Deploy Integraton Monitors 3. Field mapping tasks - "How to 
config FM for CE/LE/M?T"? 4. EMS Metrics custom topology 
flow)When using field mapping, you can use the field mapping fields 
as an input for topology script. For example, if using common event 
mapping, you can access the value of the Category field in the 
following way:
category = Framework.getDestinationAttribute("Category")

➤ In addition, you can access values of the "monitor variables", such as 
group0, group1, and so forth, from Technology Log File Integration 
monitor, or the names of database columns in Technology Database 
Integration monitor, or other variables in the other integration 
monitors. For example, you can access the value of the group1 variable, 
in the following way:
group1 = Framework.getDestinationAttribute("group1")
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Tip: To troubleshoot topology issues, see "Business Service Management 
Topology Issues" in Best Practices for the SiteScope-Business Service 
Management/Operations Manager Integration.

 8 View Integration Results

After configuring the HI and KPI assignments in BSM and the monitor in 
SiteScope (including field mapping and topology script), you can view the 
results.

➤ Create a view in RTSM to view the results of the integration in BSM’s 
Service Health or Service Level Management application. The view 
should describe the topology you defined in step 7.

For details on creating the view, see "Modeling Studio Page" in the 
Modeling Guide in the BSM Documentation Library.

If you defined the integration for SLM as well, you can view the 
integration results in SLM reports. For more information on SLM and 
on the reports, see "Working with the Service Level Management 
Application" in Using Service Level Management in the BSM 
Documentation Library.

➤ You can also view the integration data in System Availability 
Management reports. In the different reports, specify a filter for the 
data that you want to be displayed in the graphs.

Configure the filter to include the following values that you defined in 
the field mapping in step 6:

➤ Target: Select a value that was defined in the TargetName field in the 
Integration Monitor Field Mapping.

➤ Monitor type: Select a value that was defined in the MonitorType in 
the Integration Monitor Field Mapping.

➤ Monitor title/name: Select a value that was defined in the 
MonitorName in the Integration Monitor Field Mapping.
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➤ Measurement: Select a value that was defined in the 
MeasurementName(x) in the Integration Monitor Field Mapping.
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Example – Create a Metrics Flow With Custom Topology

This example describes how to create an integration monitor to capture and 
forward metrics samples from a third-party system that monitors different 
Oracle databases to BSM using the custom topology script template. This 
template enables you to create your own topology.

Note: For a task related to this example, see "Create a Metrics Flow With 
Custom Topology" on page 47. 

This example includes the following steps:

➤ "Design Stage" on page 56

➤ "Select an Indicator" on page 58

➤ "Define an HI Assignment" on page 59

➤ "Define a KPI Assignment" on page 61

➤ "Configure Field Mapping" on page 63

➤ "Create the Custom Topology Script" on page 65

➤ "View Integration Results" on page 66

 1 Design Stage

You have an application named My Oracle Monitoring. This application 
writes measurements from Oracle databases running on different 
computers to a log file. 

Since the application writes to log files, create a Technology Log File 
Integration monitor for the integration. The topology that you want to 
report includes Oracle CIs, and you will create a HI on these CIs. You will 
focus on one indicator and one measurement that you are interested in.

Entries in the log file:

➤ amrnd153,27,1,good

➤ amrnd153,82,1,warning
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➤ amrnd153,80,1,warning

The monitor:
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 2 Select an Indicator

For the My Oracle Monitoring application, use the CPU Usage by SQL 
(Database) indicator. This indicator reports SQL as well as Oracle usage.

This indicator is defined on the Oracle CI type (the CI that will be 
reported), and is appropriate for the measurement being read from the 
log. This measurement describes the amount of CPU that Oracle uses.
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 3 Define an HI Assignment

Next you create the indicator assignment in Service Health.
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You can see that for the Monitored by condition, you entered My Oracle 
Monitoring Integration. This value helps you distinguish Oracle CIs reported 
by this integration from other Oracle CIs that are being reported. This 
assigns the CPU Usage by SQL indicator on the Oracle CIs that are 
reported by this integration only.

If you edit the indicator in this assignment, you get this:

The CPU Usage by SQL indicator is calculated using the SiteScope Worst 
Status Rule. The selector defines that samples of type ss_t (the metrics 
sample type) with the same ci_id and eti_id as the current CI and ETI are 
captured by this indicator on this Oracle CI. You do not want other 
samples to be captured.
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 4 Define a KPI Assignment

Since you used a default indicator, you do not need to create a KPI 
assignment as there is an existing Service Health KPI assignment on 
Oracle CIs.
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Select the Software Performance KPI:

You can see that one of the indicators related to this KPI is the CPU Usage 
by SQL indicator which you used. 
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 5 Configure Field Mapping

This is the field mapping for the integration:

[$DEFAULT_PARAMETERS$]
# Time stamp in seconds since Jan 1st 1970 format.
# Use time() to get the sitescope host time or str_to_seconds() to read a value from 
the input event
TimeStamp:DOUBLE=time()

# Quailty in SiteScope terms: QUALITY_ERROR, QUALITY_WARNING, 
QUALITY_GOOD
Quality:INT=$group3.equals("error") ? QUALITY_ERROR : 
$group3.equals("warning") ? QUALITY_WARNING : QUALITY_GOOD

# Logical monitor name (e.g. "Whatsup Gold log integration")
MonitorName="My Oracle mon on " + $group0

# The name of the host / device that caused this event. If the name cannot be 
determined an IP address can be used instead
TargetName=$group0

# The status string of the monitor (e.g: "Log file read, 3 matches found")
MonitorState="running..."

# The monitor type (e.g. "My Log Monitor", "Third Party CPU Monitor")
MonitorType="My Oracle"

# Measurement name (e.g. "matches per minute", "CPU Utilization")
MeasurementName(1)="oracle cpu usage"
# Value as double
Value(1):DOUBLE=parseDouble($group1)
# ETI name (optional, can be also configured in the BSM measurement-to-indicator 
mapping if no custom topology script is defined)
MeasurementETI(1)="CPU Usage by SQL"
# CI resolution hint (optional, required only if "custom topology" or "no topology" 
option is selected in monitor topology settings)
MeasurementCIHint(1)="mainInstance@@" + $group0
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(continued)

You can see that you defined a new monitor type: My Oracle. 

The monitor name is My Oracle mon on $group0 where $group 0 is also the 
target computer on which the Oracle database is running.

The measurement name is oracle cpu usage and its value is taken from the 
log file. The quality that is sent is conditional and depends on what is 
written in the log file.

The ETI to which the measurement is mapped is CPU Usage by SQL.

The CI hint is in the format <<oracle sid>>@@<<computer name>>. The 
CI hint helps the CI Resolver in BSM to find the CI to which this data 
sample should be attached.

############################################################
# In order to send more than one measurement    #
# per DB row / Log file line add pairs                     #
# MeasurementName(*)=                   #
# Value(*):DOUBLE=           #
#   MeasurementETI(*)=                            #
#   MeasurementCIHint(*)=                   #
# where * = 1,2,.,n           #
# ##########################################################

[allR]
$MATCH=true
$ACTION=SEND(ss_t)
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 6 Create the Custom Topology Script

This is the topology script you created:

You can see that:

➤ system_lib.createNode(Framework) creates the node on which the 
database is running. 

➤ modeling.createDatabaseOSH creates the Oracle CI. 

➤ mainInstance is the SID of the Oracle you used.

➤ My Oracle Monitoring integration is the monitored_by attribute which is 
the condition you gave in the indicator assignment (see "Define an HI 
Assignment" on page 50).

import system_lib
import modeling

# Java imports
from java.lang import * 
from java.util import *
from appilog.common.system.types.vectors import ObjectStateHolderVector
from appilog.common.system.types import ObjectStateHolder
from appilog.common.system.types import AttributeStateHolder
from appilog.common.system.types.vectors import StringVector

def DiscoveryMain(Framework(:
global OSHVResult
OSHVResult = ObjectStateHolderVector()
# creating the node
node = system_lib.createNode(Framework)
(OSHVResult.add(node

# creating the oracle ci
monitorTarget = Framework.getDestinationAttribute("TargetName") 
"databaseSid = "mainInstance
(oracle =  modeling.createDatabaseOSH("oracle",databaseSid,None,None,node
()monitoredByList = StringVector
("monitoredByList.add("My Oracle Monitoring integration
((oracle.setAttribute(AttributeStateHolder("monitored_by", monitoredByList
("oracle.setBoolAttribute("root_enableageing", "true
OSHVResult.add(oracle)

return OSHVResult
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 7 View Integration Results

Finally, you created a view for the integration, and this is what is 
displayed in BSM’s Service Health:

These are the results of the indicator status on the monitored machine:

The state and value are the same as you assigned in the field mapping.
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3
EMS Metrics Flow With 
Computer/Monitor Topology - Best 
Practices

This chapter includes:

➤ "Create a Metrics Flow With Computer - Monitor Topology" on page 67

➤ "Example – Create a Metrics Flow With Computer - Monitor Topology" on 
page 71

Create a Metrics Flow With Computer - Monitor Topology

This task describes the steps involved in designing and implementing the 
EMS metrics flow using the Computer - Monitor topology script template. 
The topology describes a Computer CI connected to a SiteScope monitor CI 
with a Monitored By link.

Note: For an example of this task, see "Example – Create a Metrics Flow With 
Computer - Monitor Topology" on page 71. 

This task includes the following steps:

➤ "Design the topology flow" on page 68

➤ "Map Metrics to Indicators" on page 68

➤ "Map Metrics to Indicators in SAM Administration" on page 68

➤ "Define Field Mapping" on page 69
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➤ "Select a Topology Script" on page 70

➤ "View Integration Results" on page 70

 1 Design the topology flow

Before you start, plan the following:

➤ The type of the monitor and the metrics you will have.

➤ The HIs you want to be created on the Computer CI you will report in 
topology.

➤ For most of the default HIs, there are already HI and KPI assignments, 
and there is no need to create new ones.

➤ The metrics you want to map to the HIs.

 2 Map Metrics to Indicators

There are two ways to define the mapping of your metrics to HIs:

➤ In System Availability Management (SAM) Administration. Use this 
option to create a general mapping for your monitor type, or if you 
want to use regular expressions for the measurements in the mapping. 
For details, see step 3: "Map Metrics to Indicators in SAM 
Administration" on page 68.

➤ In the Field Mapping of the technology integration monitor. Use this 
option for simpler cases. For example, if you want to define a mapping 
between a metric to an HI without using regular expressions. For 
details, see step 4: "Define Field Mapping" on page 69.

 3 Map Metrics to Indicators in SAM Administration

Define the mappings in SAM Administration:

 a In BSM, select Admin > System Availability Management > Metrics and 
Indicators. 

 b Click Select Monitor and then click the New Monitor button.
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 c Enter the details of the new monitor type:

➤ Monitor display name: Enter the name of the monitor that will be 
displayed in the monitor list when you click the Select Monitor 
button.

➤ Monitor topaz name: Enter the type of the monitor as you will 
define in your field mapping (see step 4: "Define Field Mapping" on 
page 69).

➤ Monitor class name: Enter the type of the monitor as you will define 
in your field mapping (see step 4: "Define Field Mapping" on 
page 69). 

➤ Monitor Category: Enter Custom.

For more details, see "Create New Monitor Dialog Box" in Using System 
Availability Management in the BSM Documentation Library.

 d Select the new monitor type.

 e Create new indicator mappings for this monitor. For details on how to 
create the indicator mapping, see "Metrics and Indicators Tab" in Using 
System Availability Management in the BSM Documentation Library.

 f Click Publish Changes to publish the changes you made to SiteScope. 
The changes should reach SiteScope within no more than 5 minutes.

 4 Define Field Mapping

In the Field Mapping section of the integration monitor in SiteScope, 
select the Metrics field mapping script and define the field mapping.

➤ If you used SAM Administration to define the indicator mapping (see 
step 3 on page 68), enter the monitor name you used in the indicator 
mapping in SAM Administration for the MonitorType value.

➤ For the MeasurementETI(x) value, if you already defined a mapping 
between the metric and the indicator in SAM Administration (see 
step 3 on page 68), this field should not be set (keep it commented 
out). Otherwise, it should be uncommented and you should enter the 
label (display name) of one of the existing indicators that is defined on 
the Computer CI that suits your requirements. For example, CPU Load, 
for a measurement that checks CPU usage.
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➤ The MeasurementCIHint(x) value should not be set (keep it 
commented out), since SiteScope sets the CI hint automatically.

For more details on values for the metrics script, see "Configuring Field 
Mapping for Metrics Samples" in Using SiteScope.

 5 Select a Topology Script

In the Topology Settings section of the integration monitor, select 
Computer - Monitor from the Topology template list. You do not need to 
fill any topology script.

 6 View Integration Results

After defining metrics assignments and configuring the monitor in 
SiteScope (including field mapping and topology script), you can view the 
results in the following applications:

In Service Health:

 a In BSM, select Applications > Service Health > Top View. 

 b In the drop down list, select:

➤ System Hardware Monitoring to view the status of the Computer 
CI.

➤ System Monitors view to view the monitor and its status.

In SAM Reports:

You can also view the data of your integration in SAM reports. In the 
different reports, specify a filter for the data that you want to be displayed 
in the graphs.

Configure the filter to include the following values that you defined in 
the field mapping in step 4:

➤ Target: Select a value that was defined in the TargetName field in the 
Integration Monitor Field Mapping.

➤ Monitor type: Select a value that was defined in the MonitorType in the 
Integration Monitor Field Mapping.

➤ Monitor title/name: Select a value that was defined in the 
MonitorName in the Integration Monitor Field Mapping.
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➤ Measurement: Select a value that was defined in the 
MeasurementName(x) in the Integration Monitor Field Mapping.

Example – Create a Metrics Flow With Computer - Monitor 
Topology

This example describes how to create an integration monitor to capture and 
forward metrics samples from a third-party system that monitors different 
disks to BSM using the Computer - Monitor topology script.

Note: For a task related to this example, see "Create a Metrics Flow With 
Computer - Monitor Topology" on page 67. 

This example includes the following steps:

➤ "Design stage" on page 71

➤ "Map Metrics to Indicators in SAM Administration" on page 72

➤ "Define the Field Mapping" on page 74

➤ "Select a Topology Script" on page 75

➤ "View Integration Results" on page 76

 1 Design stage

You have a third-party application that writes to a log file. It writes to the 
log the disk usage of different computers. 

Since the application writes to log files, create a Technology Log File 
Integration monitor for the integration. Use the Metrics field mapping 
and the Computer - Monitor topology script template, and select the Host 
Disk Utilization indicator. There is no need to create assignments for this HI 
or KPI since there are existing assignments for them.
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Entries in the log file:

➤ labamrnd42,disk,d,65,warning

➤ labamrnd42,disk,d,70,warning

➤ labamrnd42,disk,d,70,warning

 2 Map Metrics to Indicators in SAM Administration

Create a new monitor type in BSM > Admin > System Availability 
Management > Metrics and Indicators.

My Disk Usage is the monitor type and Custom is the category.
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Now, define a new indicator mapping for the monitor:

This is how the table looks when you save it:
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 3 Define the Field Mapping

This is the field mapping you use:

[$DEFAULT_PARAMETERS$]
# Time stamp in seconds since Jan 1st 1970 format.
# Use time() to get the sitescope host time or str_to_seconds() to read a value from 
the input event
TimeStamp:DOUBLE=time()

# Quailty in SiteScope terms: QUALITY_ERROR, QUALITY_WARNING, 
QUALITY_GOOD
Quality:INT=$group4.equals("error") ? QUALITY_ERROR : 
$group4.equals("warning") ? QUALITY_WARNING : QUALITY_GOOD

# Logical monitor name (e.g. "Whatsup Gold log integration")
MonitorName="Disk Usage on " + $group0

# The name of the host / device that caused this event. If the name cannot be 
determined an IP address can be used instead
TargetName=$group0

# The status string of the monitor (e.g: "Log file read, 3 matches found")
MonitorState="Checking disk utilization..."

# The monitor type (e.g. "My Log Monitor", "Third Party CPU Monitor")
MonitorType="My Disk Usage"

# Measurement name (e.g. "matches per minute", "CPU Utilization")
MeasurementName(1)="disk " +$group2 + " utilization"
# Value as double
Value(1):DOUBLE=parseDouble($group3)
# ETI name (optional, can be also configured in the BSM measurement-to-indicator 
mapping if no custom topology script is define)
#MeasurementETI(1)=
# CI resolution hint (optional, required only if "custom topology" or "no topology" 
option is selected in monitor topology settings)
#MeasurementCIHint(1)=
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(continued)

You can see that the MonitorType value is My Disk Usage (as defined in 
the indicator mapping in SAM Administration).

The measurement matches the regular expression defined in the indicator 
mapping: MeasurementName(1)="disk " +$group2 + " utilization".

MeasurementETI(1) is commented out since you already defined a 
mapping in SAM Administration.

MeasurementCIHint(1) is commented out since SiteScope sets the hint 
automatically.

 4 Select a Topology Script

Select the Computer - Monitor script from the Topology template list. 

############################################################
# In order to send more than one measurement    #
# per DB row / Log file line add pairs                     #
# MeasurementName(*)=                   #
# Value(*):DOUBLE=           #
#   MeasurementETI(*)=                            #
#   MeasurementCIHint(*)=                   #
# where * = 1,2,.,n           #
# ##########################################################

[allR]
$MATCH=true
$ACTION=SEND(ss_t)
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 5 View Integration Results

You can view the target computer being monitored (labamrnd42) in the 
System Hardware Monitoring view of the Service Health application.

These are the results of the indicator status on the monitored machine:



77

4
EMS Metrics Flow With No Topology - 
Best Practices

This chapter includes:

➤ "Create a Metrics Flow With No Topology" on page 77

➤ "Example – Create a Metrics Flow With No Topology" on page 84

Create a Metrics Flow With No Topology

This task describes the steps involved in designing and implementing the 
EMS metrics flow using the No Topology script template.

Use this flow to use integration monitors to send metrics samples for an 
already existing topology in BSM. In this flow, SiteScope sends data without 
sending topology.

Note: For an example of this task, see "Example – Create a Metrics Flow With 
No Topology" on page 84. 

This task includes the following steps:

➤ "Design the topology flow" on page 78

➤ "Change the CI Resolver TQL" on page 78

➤ "Select an Indicator" on page 79

➤ "Define an HI Assignment" on page 80

➤ "Define a KPI Assignment for each CI type" on page 81
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➤ "Configure Field Mapping" on page 82

➤ "View Integration Results" on page 82

 1 Design the topology flow

The first stage in creating an EMS integration for metrics samples using 
No Topology is the design. When planning the design strategy, you need 
to consider the following:

➤ CIs for topology

Since you are using the No Topology option, you probably already 
have CIs in the RTSM to which you want to report data using EMS 
monitors.

➤ Data that you want to be reported for these CIs

Consider what data you have for these CIs and how it can be attached 
to the CIs. What is the relevant health indicator (HI) for the data being 
reported? If there is no such indicator, consider creating a new HI. 
Which KPI or HI assignments create the desired HIs and KPIs? If no 
such assignments exist, consider creating your own.

For example, if you have data on CPU usage and network usage, you 
can use the CPU Load and Interface Utilization HIs that are defined for 
the Computer CI type, and you can use the System Performance KPI. 
Check if there are HI and KPI assignments that meet your needs, and if 
not, consider creating them.

 2 Change the CI Resolver TQL

 a In BSM, select Admin > Platform > Infrastructure Settings. 

➤ Select Applications.

➤ Select End User/System Availability Management.

➤ In the End User/System Availability Management - SiteScope CI 
Resolver Settings, change the value of the TQL Queries parameter 
from CIs Monitored by SiteScope to OMiAutoView. 
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 b Restart BSM to apply the change.

Note: This TQL does not support models with a large number of CIs (it 
may cause performance problems in such models).

 3 Select an Indicator

To view the status of a CI, you need an HI which provides a fine-grained 
measure of the health of the CI. In most cases, you want to view the HI in 
BSM’s Service Health. The HI is also used in Service Level Management 
(SLM). For details on HIs in Service Health and SLM, see "Health 
Indicators and KPIs - Overview" in Using Service Health in the BSM 
Documentation Library.

Note: For alignment reasons, we recommend using an out-of-the-box HI; 
only create your own HI if you do not find an existing HI that fits your 
needs.

To select an existing HI or create a new HI:

 a In BSM, select Admin > Service Health / Service Level Management > 
Repositories > Indicators. 

 b Select a CI type.

 c Check if you already have an existing HI that fits your requirements. If 
you do not, create a new one. For details on how to create HIs, see 
"How to Create or Edit an ETI or HI Template in the Indicator 
Repository" in Using Service Health in the BSM Documentation Library 
in the BSM Documentation Library.

 d If you create a new HI, you should publish the changes to SiteScope. In 
BSM, select Admin > System Availability Management > Metrics and 
Indicators and click Publish Changes. The changes should reach 
SiteScope within no more than 5 minutes.
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 4 Define an HI Assignment

After you select an HI, you need to define an HI assignment that will 
assign the HI to a CI. The assignment also defines which data samples will 
be captured by this HI and which business rule will be used to calculate 
the status of the HI according to the data samples.

For more information on HI assignments in Service Health, see "Health 
Indicator Assignments Page" in Using Service Health in the BSM 
Documentation Library. For more information on HI assignments in SLM, 
see "Health Indicator Assignments Page" in Using Service Level Management 
in the BSM Documentation Library.

To define an HI assignment:

 a In BSM, select Admin > Service Health / Service Level Management > 
Assignments > Health Indicator Assignments. 

 b Select a CI type.

 c Create a new HI assignment. For details on how to create the 
assignment, see "How to Define a KPI or HI Assignment" in Using 
Service Health or "How to Define a KPI or HI Assignment" in Using 
Service Level Management in the BSM Documentation Library.

➤ In the Condition area, enter a unique value for your integration in the 
Monitored By field. This enables you to distinguish between the CIs 
reported by your integration to other CIs of this type which are not 
reported by the integration.

➤ Select the HI you chose in step 3.

➤ Choose the business rule to use for the HI calculation. We recommend 
using the SiteScope Worst Status Rule. You can also use the SiteScope 
Consecutive Worst Status Log or SiteScope Best Status Rule.

➤ In the selector, enter the following:

➤ eti_id = (Binary)  <<Health Indicator Type ID>>

➤ ci_id = (Binary)  <<CI ID>>

➤ sampleType = (String) ss_t

The integration monitor sends metrics samples (ss_t) that contain the 
same eti_id as your ETI and same CI ID as the CI's.
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The eti_id in the sample is sent by SiteScope according to your field 
mapping entry for the monitor in step 6.

The ci_id is found by the CI resolver in BSM. For it to find the CI, it 
uses the CI hint sent by SiteScope in the sample, according to your 
field mapping entry for the monitor in step 6.

For details on field mapping for metrics samples, see "Configuring 
Field Mapping for Metrics Samples" in Using SiteScope.

 5 Define a KPI Assignment for each CI type

Verify whether you have an appropriate KPI assignment, or create one if 
one does not already exist. The assignment determines which KPI to 
assign to the CI and for which HIs.

If you use one of the default HIs then there should already be a default 
KPI assignment for your HI and you do not need to create one. 

➤ For more information on KPI assignments in Service Health, see "KPI 
Assignments Page" in Using Service Health in the BSM Documentation 
Library.

➤ For more information on KPI assignments in SLM, see "KPI 
Assignments Page" in Using Service Level Management in the BSM 
Documentation Library.

To create a KPI assignment:

 a In BSM, select Admin > Service Health > Repositories > Indicators. 

 b Choose the type of your CI.

 c Create a new KPI assignment. For details, see "How to Define a KPI or 
HI Assignment or "Applications" in Using Service Health or "How to 
Define a KPI or HI Assignment" in Using Service Level Management in the 
BSM Documentation Library.

 d In the KPI assignment, the related HI should be the one you chose in 
step 3.
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Note: If you also want to view the integration results in Service Level 
Management (SLM), you need to define the Service Level Agreement 
(SLA). For more information on SLAs, see "Agreements Manager Page" 
in Using Service Level Management in the BSM Documentation Library.

 6 Configure Field Mapping

Now it is time to configure the monitor. In the Field Mapping section of 
the integration monitor, select the Metrics sample type to load the 
metrics script, and enter the details you want to send in the ss_t sample 
file. 

➤ For the MeasurementETI value, enter the label of the HI you chose 
previously in step 3. 

➤ Enter a hint for the CI in MeasurementCIHint. This hint helps the CI 
resolver in BSM to recognize the CI to which the sample should be 
attached. 

For details on values for the metrics script, see "Configuring Field 
Mapping for Metrics Samples" in Using SiteScope.

 7 View Integration Results

After configuring the HI and KPI assignments in BSM and the monitor in 
SiteScope (including field mapping), you can view the results.

➤ Create a view in RTSM to view the results of the integration in BSM’s 
Service Health or Service Level Management application. The view 
should describe the CIs you want to view.

For details on creating the view, see "Modeling Studio Page" in the 
Modeling Guide in the BSM Documentation Library.

If you defined the integration for SLM as well, you can view the 
integration results in SLM reports. For more information on SLM and 
on the reports, see "Working with the Service Level Management 
Application" in Using Service Level Management in the BSM 
Documentation Library.
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➤ You can also view the integration data in System Availability 
Management reports. In the different reports, specify a filter for the 
data that you want to be displayed in the graphs.

Configure the filter to include the following values that you defined in 
the field mapping in step 6:

➤ Target: Select a value that was defined in the TargetName field in the 
Integration Monitor Field Mapping.

➤ Monitor type: Select a value that was defined in the MonitorType in 
the Integration Monitor Field Mapping.

➤ Monitor title/name: Select a value that was defined in the 
MonitorName in the Integration Monitor Field Mapping.

➤ Measurement: Select a value that was defined in the 
MeasurementName(x) in the Integration Monitor Field Mapping.
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Example – Create a Metrics Flow With No Topology

This example describes how to create an integration monitor to capture and 
forward metrics samples from a third-party system that monitors different 
Oracle databases to BSM using the No Topology flow. This flow is used to 
send metric samples when a topology already exists in BSM, and there is no 
need to report the CIs. 

Note: For a task related to this example, see "Create a Metrics Flow With No 
Topology" on page 77. 

This example includes the following steps:

➤ "Design Stage" on page 84

➤ "Select an Indicator" on page 86

➤ "Define an HI Assignment" on page 86

➤ "Define a KPI Assignment" on page 88

➤ "Define the Field Mapping" on page 90

➤ "View Integration Results" on page 92

 1 Design Stage

You have an application named My Oracle Monitoring. This application 
writes various measurements from Oracle databases running on different 
computers to a log file. 

Since the application writes to log files, you need to create a Technology 
Log File Integration monitor for the integration. The measurements will 
be assigned to Oracle CIs that already exist in RTSM; therefore the CIs do 
not need to be reported. The data is assigned to HIs on the CIs. You will 
focus on one indicator and one measurement that you are interested in.

Entries in the log file:

➤ amrnd153,27,1,good

➤ amrnd153,82,1,warning
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➤ amrnd153,80,1,warning

The monitor:
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 2 Select an Indicator

For the My Oracle Monitoring application, use the CPU Usage by SQL 
(Database) indicator. This indicator reports SQL as well as Oracle usage.

This indicator is defined on Oracle CI type and is appropriate for the 
measurement being read from the log. This measurement describes the 
amount of CPU that Oracle uses.

 3 Define an HI Assignment

Next you create the indicator assignment in Service Health. The 
assignment condition should match the Oracle CIs on which you want to 
define the indicators (and not other Oracle CIs that do not belong to this 
integration).

In the indicator assignment, select the CPU Usage by SQL HI. If you edit 
the indicator in this assignment, you get this:
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The CPU Usage by SQL indicator is calculated using the SiteScope Worst 
Status Rule. The selector defines that samples of type ss_t (the metrics 
sample type) with the same ci_id and eti_id as the current CI and ETI are 
captured by this indicator on this Oracle CI. You do not want other 
samples to be captured.
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 4 Define a KPI Assignment

Since you used a default indicator, you do not need to create a KPI 
assignment as there is an existing Service Health KPI assignment on 
Oracle CIs.
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Select the Software Performance KPI:

You can see that one of the indicators related to this KPI is the CPU Usage 
by SQL indicator which you used. 
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 5 Define the Field Mapping

This is the field mapping for the integration:

[$DEFAULT_PARAMETERS$]
# Time stamp in seconds since Jan 1st 1970 format.
# Use time() to get the sitescope host time or str_to_seconds() to read a value from 
the input event
TimeStamp:DOUBLE=time()

# Quailty in SiteScope terms: QUALITY_ERROR, QUALITY_WARNING, 
QUALITY_GOOD
Quality:INT=$group3.equals("error") ? QUALITY_ERROR : 
$group3.equals("warning") ? QUALITY_WARNING : QUALITY_GOOD

# Logical monitor name (e.g. "Whatsup Gold log integration")
MonitorName="My Oracle mon on " + $group0

# The name of the host / device that caused this event. If the name cannot be 
determined an IP address can be used instead
TargetName=$group0

# The status string of the monitor (e.g: "Log file read, 3 matches found")
MonitorState="running..."

# The monitor type (e.g. "My Log Monitor", "Third Party CPU Monitor")
MonitorType="My Oracle"

# Measurement name (e.g. "matches per minute", "CPU Utilization")
MeasurementName(1)="oracle cpu usage"
# Value as double
Value(1):DOUBLE=parseDouble($group1)
# ETI name (optional, can be also configured in the BSM measurement-to-indicator 
mapping if no custom topology script is defined)
MeasurementETI(1)="CPU Usage by SQL"
# CI resolution hint (optional, required only if "custom topology" or "no topology" 
option is selected in monitor topology settings)
MeasurementCIHint(1)="mainInstance@@" + $group0
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(continued)

You can see that a new monitor type was defined: My Oracle.

The monitor name is My Oracle mon on $group0 where $group 0 is also the 
target computer on which the Oracle database is running.

The measurement name is oracle cpu usage and its value is taken from the 
log file. The quality that is sent is conditional and depends on what is 
written in the log file.

The ETI to which the measurement is mapped is CPU Usage by SQL.

The CI hint is in the format <<oracle sid>>@@<<computer name>>. The 
CI hint helps the CI Resolver in BSM to find the CI to which this data 
sample should be attached.

############################################################
# In order to send more than one measurement    #
# per DB row / Log file line add pairs                     #
# MeasurementName(*)=                   #
# Value(*):DOUBLE=           #
#   MeasurementETI(*)=                            #
#   MeasurementCIHint(*)=                   #
# where * = 1,2,.,n           #
# ##########################################################

[allR]
$MATCH=true
$ACTION=SEND(ss_t)
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 6 View Integration Results

Finally, you created a view for the integration, and this is what is 
displayed in BSM’s Service Health:

These are the results of the indicator status on the monitored machine:

The state and value are the same as you assigned in the field mapping.
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